BIT 260
 In-Class Exercises
Lecture 3

Dialogs, Menus, and Controls, Oh My!
Note:  Please keep the programs that you create today, in case you have a dispute about your grades for the ICEs at the end of the quarter

“Optional” exercises don’t need to be done if you’re making up this work (i.e., you missed class, and you’re doing the work on your own)


Throughout this class, you should look for opportunities to make your application look professional.  While you should clearly be focusing on the new topic that is being presented, you should take advantage of any small opportunities to make the program easier to use.  For example, setting the Text of a Button to a String that explains what the button does is quick, and greatly aids usability.

Part 1: Common Dialogs: Selecting Color
Create a new project, and save it somewhere (remember, save early, save often!), then put a 2 Buttons on the form, and a Label.  Put a reasonable starting message into the Label.  When the user clicks one of the buttons, they’ll see a ColorDialog “Common Dialog” box appear.  If the user exited the dialog by selecting “OK”, then you should set the color of the foreground (i.e., the color of the text) to be whatever the user picked.
Part 2: Common Dialogs: Selecting (Multiple) Files
Continue working with the project that you created in the previous part.

When the user clicks the other button, the user will be allowed to select multiple files from the OpenFileDialog common dialog.  If the user exits the dialog by selecting “Ok”, you should set the text of the label to be a list of ALL the files selected.
Notice that the OpenFileDialog doesn’t allow for multiple selections by default – you’ll need to first locate which property controls this, then (within your code) make sure to set that property to True before you use the ShowDialog method.

After the dialog has finished, you’ll need to iterate through the array of filenames, and concatenate each onto a String.  If you wish to insert a new line (a.k.a. line break, a.k.a. carriage return – this is what’s added when you hit the <Enter> / <Return> key), you can use the VB constant vbNewline:

        Dim s As String = "Hello" & vbNewLine & "World"

        MessageBox.Show(s)

        ' you’ll see:

        '

Hello

   '

World
Part 3: Custom Properties (Optional (If You’re Not In Class) )

The purpose of this exercise is to give you a chance to create a custom property, separate from a custom dialog box.

Continue working with the project that you created in a previous part.  Add a Public Property to the form itself (if you’ve got a separate class handy, feel free to add it to the class, instead).  Feel free to give the property any (data) type you want – an Integer would work well.
For the “Set” part of the property, include code to check that the value you’re given is zero or greater.  If it’s not, then set the property to zero.  (You’ll see exception handling in class soon ; this would be a good place to throw an exception).  For the “get” version, simply return the value.
For the GUI part of the exercise, you might create a Textbox/Label/Button setup – when the button is pressed, the program converts whatever’s in the Textbox to an integer, and tries to store it in the form’s new property.  It then gets the property, and sets the Label’s text to indicate what the property currently is.


Feel free to deviate from this exercise - anything that shows you’ve got a decent handle on properties is sufficient.
Part 4: Custom Dialogs
Create a new project, and save it somewhere (remember, save early, save often!), then put a Button on the form.  When the button is clicked, the user will be shown a custom dialog box that asks the user for their name.  For example:
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Curent User: None.

Show the Custom Dialog Box





The Starting Form
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The Custom Dialog Box

When the user clicks on 

 that button, they’ll see the dialog.

If the user exits the dialog by typing 

a name, and clicking “Ok”, the program

will update the display.




Remember that you’ll have to create your custom dialog box as a separate form, then set various properties as listed on the following page
	Property
	Set To
	Why?

	ControlBox
	False
	This will disable the “system menu” on the top-left corner of the window.  Also, that little “VB App” icon will go away

	FormBorderStyle
	FixedDialog
	The border of the form now looks like a dialog

The form can no longer be re-sized
(The normal option is “Sizable” if you want to change it back)

	ShowInTaskBar
	False
	Form won’t be displayed in Task bar

	StartPosition
	CenterParent
	So it’ll show up in the right place

	MaximizeBox
	False
	So the user can’t change the size

	MinimizeBox
	False
	So the user can’t change the size

	AcceptButton
	btnOk
	When the user hits the “Enter” key, btnOk will be (programmatically) pressed.

UNLESS the currently selected control (such as a multi-line text box) can grab the Enter key

Note: btnOk should match whatever you put on your form.

	btnOk.DialogResult
	OK
	So when the user clicks on the button, the ShowDialog routine will know that the user has selected “Cancel”

	CancelButton
	btnCancel
	When the user hits the “ESC” key, btnCancel will be (programmatically) pressed.

	btnCancel.DialogResult
	
	So when the user clicks on the button, the ShowDialog routine will know that the user has selected “Cancel”


Further, your new custom dialog box should a “UserName” property (don’t try naming your new property “Name” – that will conflict with something in a base class).  The event handler for the “OK” button’s Click event should set this property to be whatever the user typed into the TextBox.
Once you’ve done that, your main/startup form will simply create the custom dialog box, use the ShowDialog method on it, then (if the user selected “ok” to exit the dialog) get the UserName property, and update the Label with it.
Part 5: Main Menu
Within the project that you’re working on, create a new MainMenu (by dragging it from the ToolBox).  Create File, Format, and Data menus.  On the File menu, put Open File (which should open your multi-select OpenFileDialog, as in the “common dialog” exercise), a separator, and the Exit item (which simply does an Application.Exit).  On the Format menu, put Choose Color, and Choose Font, each of which should use a common dialog to set the color of the Label that’s already on the form.  Finally, the Data menu should use your custom dialog box as a means of allowing the user to set the UserName property on the form.
Part 6: Context Menus
Within your current project, create a context menu for the Label. Do this by dragging the ContextMenu from the ToolBox on the form (and renaming the new  menu), then setting the Label’s ContextMenu property to the new menu, and adding Choose Color, Set User Name and Choose Font to the context menu.  Just like the prior exercise, these items should change the appearance of the Label.
Part 7: Factoring Your Code (Optional)

Even though this exercise is optional, it’s good to think about how you’d deal with this issue, and evaluate various possible solutions.
After finishing the previous exercise, you’ve now got an application that has three separate ways of invoking your custom dialog box (through the button, off the Data menu, or off the context menu), and two ways of invoking the font/color picking dialog boxes.  

Think about where you’ve duplicated code in order to do this, and how you might minimize such redundancy – is it possible to forward events on to the button, instead of having the menus also use the custom dialog box?  Is this a good solution? What happens if you get rid of that button?   Could you create a new, non-visual class that has a couple of methods, and references the Label, and simply have each GUI element call the ChangeColor (or ChangeFont, or ChangeUserName) methods (which you would have to write) on your new class?
Part 7: Common Controls: TextBox

At this point, you’ve used the TextBox control several times.  Notice that in.Net, there’s only a single TextBox control for all sorts of text-entry – contrast this with HTML, wherein there are separate multi-line (TEXTAREA) and single-line (INPUT) controls.

Try playing around with the various properties that are listed in your textbook, in particular the Multiline / AcceptsReturn properties, PasswordChar (can you get the WinXP style dots to appear?), and/or WordWrap
Part 7: Common Controls: RichTextBox
A RichTextBox is very similar to Word (or perhaps more accurately, to WordPad) in that it allows you to store not just text (like the TextBox), but also formatting.  

Try creating an RTF file in Word (or WordPad), and use the LoadFile method on a RichTextBox to open that file programmatically.  The SaveFile method will then allow you to save that file back out to disk.  An interesting exercise might be to create a (main and/or context) menu that has both “Open” and “Save As” menu items connected to these methods.
The three-letter abbreviation for TextBoxes is txt, while the abbreviation for Rich Text Boxes is rtb.
As an aside, as far as I can tell, RTF is very similar to HTML in that it’s a text-based ‘mark-up’ of the underlying text.  The major differences being (as far as I know) that RTF came out several years earlier, is substantially more strict in checking tags, and it originally didn’t have any hyperlink capability.

Part 7: Common Controls: GroupBox / Panel


A GroupBox is a way of grouping together other controls, both visually, and for programmatic reasons (see the CheckBox/RadioButton exercise).  A Panel can do the same thing, and has built-in scrollbar support.  For this reason, these are sometimes call “container controls”, since they can contain other controls.

Try placing each on a form, and putting various controls within it.  Notice that you can caption the GroupBox (but not the Panel), and that the Panel has an “AutoScroll” option.
The three-letter abbreviation for GroupBoxes is grp, while the abbreviation for a Panel is pnl.
Part 7: Common Controls: CheckBox / RadioButton

Create a form that has both CheckBoxes and RadioButtons on it – make sure you create (and properly group) 2 groups of RadioButtons, so that you can make sure you know how you can use WinForms to correctly, automatically handle groups of radio buttons.  You should also put a Button on the form; when the button is pushed, the program should figure out what state all the CheckBoxes are in, and for each group of RadioButtons, which ‘button was selected (if any)
One idea might be to create a Label, and have one checkbox control whether the label is bold, another control whether it’s in italics, etc, etc. The RadioButtons might select messages to display – one group might be the start of a sentence, the other might be the ending, thus giving you a ‘Mad-Libs’ type game.  Note that unlike the example in the textbook (which uses event handlers on the CheckBoxes and RadioButtons), you need to figure out what’s going on until the Button is pushed (as you would typically do in a custom dialog)
The three-letter abbreviation for CheckBoxes is chk, while the abbreviation for a RadioButton is rb (yes, this is a two-letter abbreviation ( ).
Part 7: Common Controls: TabControl


Try experimenting with a Tab Control, and it’s subsidiary Tab Pages.  Since these controls are basically just a way of grouping other controls, find some reason for why you’d arrange the tabs as you do.  

An interesting, but very optional, experiment might be to see if you can create a ‘Wizard’ out of these – you’d need to find a way to programmatically move from tab to tab, so that you can have a “Next” button.  You might even look at disabling the tabs (perhaps by handling the SelectedIndexChanged event yourself) so that the user is forced to go through the tabs in a sequential order.

The three-letter abbreviation for Tab Controls is tab (bet you didn’t see that one coming, did you? ( ), while the abbreviation for a Tab Page is tbp.
Part 7: Common Controls: Anything Else You’d Like To Try


Keep in mind that the MCAD exam will require you to know about several other controls, and substantially more detail about all of these controls, and so it would be a good idea to practice with all of these as much as you can.
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